
About backing up and restoring information

To protect your work, use Microsoft ActiveSync to create a backup file that contains all files, databases, personal 
information manager (PIM) information, and RAM-based programs on your mobile device. The backup file is 
stored on your desktop computer.

For the greatest amount of protection, you should regularly back up information on your device. You can perform 
a backup automatically each time you connect or manually any time you want. You can also determine whether 
all or only new and updated information is backed up. 

The backup file is not password protected, even if your mobile device is. If you store sensitive information on 
your device, protect the backup file as you would any other desktop computer file that contains sensitive 
information.

When you use the backup file to restore information to your mobile device, information on the device is replaced 
with the information stored in the backup file, and the Recycle Bin is emptied. Note that restoring does not:

· Overwrite your device password.

· Restore the placement of desktop icons.

Related Topics
Automatically back up information

Manually back up information 

Restore information to your mobile device



Automatically back up information

1 Connect your mobile device.

2 On the Tools menu, click Backup/Restore, and then click the Backup tab.

3 Select Automatically back up each time the device connects. If you want to use a different backup file, 
click Change, and then select the file you want.

Note    Automatic backup is available only on mobile devices that have a partnership with the desktop computer.
To back up information on a device that is set up as a guest, manually back up information.

Related Topics
About backing up and restoring information

Manually back up information



Manually back up information

Manually back up information if your device does not have a partnership with a desktop computer or before you 
clear memory on your device.

1 On the Tools menu, click Backup/Restore, and then click the Backup tab.

2 Do one of the following:

To back up all information, select Full backup.

To back up only new and changed information, select Incremental backup.

3 Click Back Up Now. 

Related Topics
About backing up and restoring information

Automatically back up information



Restore information to your mobile device

If you have created files on your device since the last backup and don’t want them deleted during the restore 
process, move those files from your device to your desktop computer before restoring information.

1 Connect your device. If the Partnership Wizard is started, close the wizard and connect as a guest.

2 If your device does not automatically exit programs as needed, exit any open programs on your device.

3 On the Tools menu, click Backup/Restore, and then click the Restore tab.

4 Click Restore Now. Do not use your device until the restore process is complete.
Note    If you are connected as a guest, click Restore Now, and then select the partnership you want to restore.

5 Reset your device as specified in the device manufacturer’s documentation.

Related Topics
About backing up and restoring information

Move a file 



The following topic is only accessible from a Help button in an error message that users receive if restore fails. 
This topic is not accessible from the Table of Contents, Index, or Find tab.



Resolve a device mismatch

You cannot use a backup file created on one type of mobile device to restore information to a different type of 
device. Devices are considered to be different when they do not use the same processor type, version of 
Windows CE, or language. You cannot restore information backed up on an H/PC to a P/PC, or vice versa. Create a
partnership with the new device, and then synchronize or copy information from your desktop computer to the 
device.

If you have changed the device's regional settings, ActiveSync will no longer recognize it as the same type of 
device, and you will not be able to use your backup file to restore information. Change the regional setting back 
to the setting used when you created the backup file, and try to restore information again. For more information 
on changing regional settings, see Settings Help on your device.

Related Topics
About copying and moving files 

About partnerships 

About synchronization 

Restore information to your mobile device



 About ActiveSync file conversion

Files created on your desktop computer may need to be converted by Microsoft ActiveSync so that they can be 
viewed and edited on your device, and vice versa. For example, an Excel (.xls or .xlt) file can be converted to a 
Pocket Excel (.pxl or .pxt) file to be viewed in Pocket Excel. Every time you synchronize, copy, or move files, 
ActiveSync converts files as necessary.

All formatting attributes contained in device files are retained when the files get converted to their 
corresponding desktop computer files. However, converting desktop computer files to device files may cause 
some formatting attributes to:

· Be displayed on the device and remain unchanged in the original files on the desktop computer.

· Be changed when converted to device files and not be restored when converted back to desktop files.

· Not be displayed on the device but be restored when converted back to desktop computer files.

· Be removed when converted to device files and not be restored when converted back to desktop files.
To avoid losing or permanently modifying formatting attributes, close the file after viewing it on your device 
rather than saving it.

The following topics provide details about the types of formatting attributes and features contained in desktop 
computer files that are supported or not supported in device programs.

Convert database files for use on a mobile device

Convert Excel files for use on a mobile device

Convert PowerPoint files for use on a mobile device

Convert Word files for use on a mobile device

Notes

· Certain programs on your device may also have built-in converters that are used to convert files from the 
original format used on your desktop computer to a format that can be viewed on your device. For example, 
you can use these built-in converters to convert files received as e-mail attachments in Inbox on your device. 
To determine the formatting changes that may occur during conversion on your device, see Help on your 
device.

· Handwritten notes and drawings created in InkWriter or NoteTaker are converted to Word (.doc) files as 
metafiles, and can only be edited on your device.

Related Topics
About copying and moving files 

Synchronize with your desktop computer 

Change the converter for a file type 

Disable file conversion 



Convert database files for use on a mobile device

ActiveSync converts Access files (.mdb) and SQL Server database (or other ODBC database) information to a 
Pocket Access (.cdb) file, and vice versa, whenever you synchronize, copy, or move information to your mobile 
device. All formatting attributes contained in Pocket Access files are retained when the files get converted to 
their corresponding desktop computer files.

During conversion to your device, many file attributes are supported and appear just as they do on your desktop 
computer. Other file attributes may be changed or removed. The following topics provide details about how 
conversion affects database information.

Database field and table conversion to Pocket Access

Database data type conversion to Pocket Access

Database index conversion to Pocket Access

Note    Each Pocket Access database is limited to 65,536 records.

Related Topics
About ActiveSync file conversion

About copying and moving files 

About synchronization 



Database field and table conversion to Pocket Access

· Fields larger than 64 KB are truncated when converted.

· Tables with names longer than 31 characters are converted with truncated names. When a table already 
exists with the truncated name, the last character of the new table's name is replaced with a 0.

· Table names that begin with “MSys” cannot be converted.

Related Topic
Convert database files for use on a mobile device 



Database data type conversion to Pocket Access

Access and SQL 
Server 

Pocket Access

AutoNumber Integer

Binary Binary

Boolean Boolean

Byte Small Integer

Currency Float

Date/Time Date/Time

Double Float

HyperLink Memo

Integer Small Integer

Long Binary OLE Object

Long Integer Integer

Lookup Wizard Text

Memo Memo

OLE Object OLE Object

Replication ID Binary

Single Float

Text Text

Yes/No Boolean

Related Topic
Convert database files for use on a mobile device 



Database index conversion to Pocket Access

· Three types of indexes are converted in the following order:

1 Primary Key indexes
(When a Primary Key consists of multiple fields, each field is converted with an individual index. The 
numbers 0-2 are added to the end of the index names. If three Primary Key indexes are created, no other 
indexes will be converted.)

2 Unique indexes
(These indexes are converted to non-unique indexes. When a Unique index consists of more than one 
field, only the first field is converted.)

3 Non-unique indexes
(When a non-unique index consists of more than one field, it will not be converted.)

· Indexes with names longer than 64 characters are converted with truncated names. If an index already exists 
in a table with that truncated name, the new index will not be converted.

· Indexes are only converted with the attributes of ascending or descending.

· Indexes are always converted as non-case sensitive.

· Indexes for fields that contain information Pocket Access can't interpret (for example, images and OLE 
objects) will not be converted.

· Fields with more than one index are converted with only one index.

· Fields with a Boolean data type are converted without an index.

Related Topic
Convert database files for use on a mobile device 



Convert Excel files for use on a mobile device

ActiveSync converts Excel (.xls or .xlt) files to Pocket Excel (.pxl or .pxt) files, and vice versa, whenever you 
synchronize, copy, or move files. All formatting attributes contained in Pocket Excel files are retained when the 
files get converted by ActiveSync to Excel files.

When using ActiveSync to convert Excel files to Pocket Excel files, many file attributes are retained and appear 
just as they do on your desktop computer. Other attributes are changed or removed. The following topics list the 
attributes that are supported or not supported in Pocket Excel.

Excel attributes supported in Pocket Excel

Excel attributes not supported in Pocket Excel

After a file is converted, you can open it using Pocket Excel on your mobile device. Your mobile device may also 
contain Excel converters. For more information, see Pocket Excel Help on your mobile device.

Related Topics
About ActiveSync file conversion

About copying and moving files 

About synchronization 



Excel attributes supported in Pocket Excel

Microsoft Excel attributes supported in Pocket Excel are either displayed without change or are slightly changed 
during conversion.

The following attributes are not changed during conversion.

· Custom and built-in number
formats

· Single-line borders

· Names that reference 
worksheets in the same 
workbook

· Wrapping text

The following attributes are changed when converting an Excel file to a Pocket Excel file and are not restored 
when converting back to an Excel file.

· All borders are changed to a
single line

· Formulas entered with a 
reference past row 16384
are replaced with #REF!

· Pivot table data is changed 
to a value

· Charts, sheets, VBA 
modules, macro sheets, and
dialog sheets are changed 
to blank sheets

· Formulas not supported 
by Pocket Excel are 
changed to a value

· Vertical text is changed to 
horizontal text

· Formulas containing an 
array or an array argument 
are changed to a value

· Formulas or functions 
that reference names 
that refer to other 
workbooks, arrays, array 
formulas, or intersection 
ranges will be resolved as
#NAME?

· Formulas containing 
external link references or 
intersection range 
references are changed to a
value

· Hidden names are 
unhidden

Related Topic
Convert Excel files for use on a mobile device 



Excel attributes not supported in Pocket Excel

Microsoft Excel attributes not supported in Pocket Excel are either restored when converted back to Excel or 
completely removed during conversion.

Cell shading is not supported in Pocket Excel but is restored when converted back to an Excel file.

The following attributes are removed when converting an Excel file to a Pocket Excel file and are not restored 
when converting back to an Excel file.

· Add-ins · Drawing objects · Protection
· Alternate palette settings · Embedded OLE objects · Routing slit settings
· AutoFilter · Excel 97 conditional formatting · Scenarios
· Cell notes · File sharing · Text boxes
· Cell patterns · Hyperlinks · Vertical alignment
· Data consolidation · Object charts · Zoom
· Data validation · Picture controls

Related Topic
Convert Excel files for use on a mobile device 



Convert PowerPoint files for use on a mobile device

You can use ActiveSync to convert a PowerPoint (.ppt) file to a Pocket PowerPoint (.ppv) file. After a file is 
converted, you can open it using Pocket PowerPoint on your mobile device. Pocket PowerPoint (.ppv) files cannot 
be converted to PowerPoint (.ppt) files.

ActiveSync offers four options when converting PowerPoint files: Compact, High Quality (640X480), High 
Quality (800X600), and High Quality (1024x768). Compact conversion results in the smallest possible file 
size. The High Quality conversion options produce files that are often larger than the original file on your desktop
computer. By default, ActiveSync uses the High Quality (640X480) option.

Caution

· Do not synchronize, copy, or move an updated Pocket PowerPoint file back to PowerPoint on your desktop 
computer. The conversion process will render your original PowerPoint file unreadable in PowerPoint on your 
desktop computer.

· When using the Compact converter, grouped objects in a PowerPoint file are converted as one image. If the 
grouped objects contain text, you may get better conversion results by ungrouping the text from the graphic 
objects. Note, however, that the file produced on your mobile device may be much larger.

Related Topics
About ActiveSync file conversion

About copying and moving files 

About synchronization 

Change the converter for a file type



Convert Word files for use on a mobile device

ActiveSync converts Word (.doc) files to the appropriate file type on the mobile device, and vice versa, whenever
you synchronize, copy, or move files. The file types that Word files can be converted to depend on the programs 
installed on your device.

What would you like to learn more about?

Word to Pocket Word conversion 

Word to InkWriter conversion 

Word to Note Taker conversion 

Word to Notes conversion 

Note    Handwritten notes and drawings created in InkWriter or NoteTaker are converted to Word (.doc) files as 
metafiles and can be edited only on your device.

Related Topics
About ActiveSync file conversion

About copying and moving files 

About synchronization 



Word to InkWriter conversion

If InkWriter is installed on your device, but Pocket Word is not, ActiveSync converts Word (.doc) files to the .pwi 
file type, and vice versa. Word templates (.dot) are also converted to the .pwi file type. Conversion takes place 
any time you synchronize, copy, or move files. All formatting attributes contained in InkWriter files are retained 
when converted to Word files.

When using ActiveSync to convert Word files to InkWriter files, many file attributes are retained and appear just 
as they do on your desktop computer. Other file attributes are changed or removed. The following topics list the 
file attributes that are supported or not supported in InkWriter.

Word attributes supported in InkWriter

Word attributes not supported in InkWriter

Notes

· Password protected Word (.doc) documents cannot be synchronized. Remove password protection in Word, 
and then synchronize the document.

· Word templates (.dot) that have been converted to InkWriter (.pwi) convert back to Word documents (.doc) 
rather than Word templates.

· Handwritten notes and drawings created in InkWriter (.pwi) are converted to Word (.doc) files as metafiles. 
These files can be edited only on your device.

· Rich Text Format (.rtf) and Text (.txt) files can be copied or synchronized without conversion.

Related Topic
Convert Word files for use on a mobile device 



Word attributes supported in InkWriter 

Microsoft Word attributes supported in InkWriter are either displayed without change or are slightly changed 
during conversion.

The following attributes are not changed during conversion.

· Bold · Italics · Paragraph alignment
· Bullets · Simple numbered lists · Paragraph spacing
· Indentation · Strikethrough

The following attributes are changed slightly when converting a Word file to an InkWriter file, and are not 
restored when converted back to a Word file.

· Index formatting is lost, but 
text remains

· Pictures with more than 
256 colors are changed to 
16 colors

· Table of contents 
formatting is lost, but text 
remains

· OLE objects are changed to 
bitmaps

· Some table formatting 
may be lost, but text 
remains

Related Topic
Word to InkWriter conversion 



Word attributes not supported in InkWriter

Microsoft Word attributes not supported in InkWriter are either restored when converted back to Word or 
completely removed during conversion.

The following attributes are mostly restored when converted back to a Word file.

· Margins · Gutter size · Header/footer 
vertical location

· Paper size

The following Word attributes are removed when converting a Word file to an InkWriter file and are not restored 
when converting back to a Word file.

· Annotations · Comments · Frames · Revision marks
· Borders · Footnotes · Headers · Shading
· Columns · Footers · Page setup 

information, such as 
paper source and 
layout

· Style sheets

Related Topic
Word to InkWriter conversion 



Word to Note Taker conversion

If Note Taker is installed on your device, ActiveSync converts Word (.doc) files to the .pwi file type, and vice 
versa. Word templates (.dot) are also converted to the .pwi file type. Conversion takes place any time you 
synchronize, copy, or move files. All formatting attributes contained in Note Taker files are retained when 
converted to Word files.

When converting Word files to Note Taker files, many file attributes are retained and appear just as they do on 
your desktop computer. Other file attributes are changed or removed. The following topics list the file attributes 
that are supported or not supported in Note Taker.

Word attributes supported in Note Taker

Word attributes not supported in Note Taker

Notes

· Password-protected Word (.doc) documents cannot be synchronized. Remove password protection in Word, 
and then synchronize the document.

· Word templates (.dot) that have been converted to Note Taker (.pwi) are converted back to Word documents 
(.doc) rather than Word templates.

· Handwritten notes and drawings created in Note Taker (.pwi) are converted to Word (.doc) files as metafiles. 
These files can be edited only on your device.

· Rich Text Format (.rtf) and Text (.txt) files can be copied or synchronized without conversion.

Related Topic
Convert Word files for use on a mobile device 



Word attributes supported in Note Taker

Microsoft Word attributes supported in Note Taker are either displayed without change or are slightly changed 
during conversion.

The following attributes are not changed during conversion.

· Bold · Italics · Paragraph alignment
· Bullets · Simple numbered lists · Paragraph spacing
· Indentation · Strikethrough

The following attributes are changed slightly during conversion when converting a Word file to a Note Taker file 
and are not restored when converted back to a Word file.

· Index formatting is lost, but 
text remains

· Pictures with more than 
256 colors are changed to 
16 colors

· Table of contents 
formatting is lost, but text 
remains

· OLE objects are changed to 
bitmaps

· Some table formatting 
may be lost, but text 
remains

Related Topic
Word to Note Taker conversion 



Word attributes not supported in Note Taker

Microsoft Word attributes not supported in Note Taker are either restored when converted back to Word or 
removed during conversion.

The following attributes are mostly restored when converted back to a Word file.

· Margins · Gutter size · Header/footer 
vertical location

· Paper size

The following Word attributes are removed when converting a Note Taker file and are note restored when 
converting back to a Word file.

· Annotations · Comments · Frames · Revision marks
· Borders · Footnotes · Headers · Shading
· Columns · Footers · Page setup 

information, such as 
paper source and 
layout

· Style sheets

Related Topic
Word to Note Taker conversion 



Word to Notes conversion

If Notes is installed on your device and you have selected to synchronize notes by using file synchronization 
rather than notes synchronization, ActiveSync converts Word (.doc) files and Word (.dot) templates to the .pwi 
file type, and vice versa. Conversion takes place whenever you synchronize, copy, or move files. After a file is 
converted, you can open it on your mobile device by using Notes.

When using ActiveSync to convert files, many file attributes are retained and appear just as they do on your 
desktop computer. Other file attributes are changed or removed. The following topics list the file attributes that 
are supported or not supported in Notes.

Word attributes supported in Notes

Word attributes not supported in Notes

Notes

· Password-protected Word (.doc) documents cannot be synchronized. Remove password protection in Word, 
and then synchronize the document.

· Word templates (.dot) that have been converted to Notes (.pwi) are converted back to Word documents (.doc)
rather than Word templates.

· Handwritten notes and drawings created in Notes (.pwi) are converted to Word (.doc) files as metafiles.

Related Topic
Convert Word files for use on a mobile device 

Modify Notes synchronization settings 



Word attributes supported in Notes

Microsoft Word attributes supported in Notes are either displayed without change or are slightly changed during 
conversion.

The following attributes are completely supported in Notes and will not be changed during conversion.

· Bold · Italics · Paragraph alignment
· Bullets · Simple numbered lists · Paragraph spacing
· Indentation · Strikethrough

The following attributes are supported in Notes, but are changed slightly during conversion. If you synchronize a 
Notes file that contains these attributes with you desktop computer, the changes will affect the original file.

· Index formatting is lost, but 
text remains

· Pictures with more than 
256 colors are changed to 
16 colors

· Table of contents 
formatting is lost, but text 
remains

· OLE objects are changed to 
bitmaps

· Table formatting is 
removed, but text is 
preserved.

Related Topic
Word to Notes conversion 



Word attributes not supported in Notes

Microsoft Word attributes not supported in Notes are either restored when converted back to Word or completely 
removed during conversion.

The following attributes are not supported in Notes, but are mostly restored when converted back to a Word file.

· Margins · Gutter size · Header/footer 
vertical location

· Paper size

Some Word attributes are not supported in Notes, and are removed during conversion. If you synchronize the 
Notes file with your desktop computer, the original file will be affected. The most common attributes that are not
supported are listed here.

· Annotations · Comments · Frames · Revision marks
· Borders · Footnotes · Headers · Shading
· Columns · Footers · Page setup 

information, such as 
paper source and 
layout

· Style sheets

Related Topic
Word to Notes conversion



Convert font files for use on a mobile device

Some mobile devices do not require conversion of font files. If your device requires font file conversion, 
ActiveSync converts fonts (in sizes you select during conversion) from your desktop computer to your device, but
not vice versa.

ActiveSync only converts .ttf file types (TrueType fonts). If you want to use .fon files, you must first use a tool that
converts .fon file types to .ttf file types, and then transfer the converted files.

To use the Wingdings or Webdings font with such programs as Pocket Word on your device, connect your device 
to your desktop computer. Copy the Wingding.ttf and Webdings.ttf files from the Font folder on your desktop 
computer to the My device\Windows folder on the mobile device.

Related Topics
About ActiveSync file conversion

Copy a file 



Convert other documents and workbooks for use on a mobile device

ActiveSync may be able to convert files created by other desktop computer programs. During setup, ActiveSync 
looks for registered converters that support converting files to or from your mobile device. For example, if you 
installed the text converters provided by Microsoft Works, you can convert between Pocket Word and Works 
documents. 

To see a list of available converters:

1 Click Options .

2 On the Rules tab, click Conversion Settings. 

3 View the list of converters in the Device to Desktop tab or Desktop to Device tab.

Related Topic
About ActiveSync file conversion



Change the converter for a file type

You can change the file converter used to convert files.

For files synchronized or copied to your mobile device

1 Click Options , and then click the Rules tab.

2 Click Conversion Settings, and then click the Desktop to Device tab.

3 Select a file type from the Desktop computer convertible file types list.

4 Click Edit, and then select a file type from the Convert to mobile device files of the type list.

For files synchronized or copied to your desktop computer

1 Click Options , and then click the Rules tab.

2 Click Conversion Settings, and then click the Device to Desktop tab.

3 Select a file type from the Mobile device convertible file types list.

4 Click Edit, and then select an option from the Convert to desktop computer files of the type list.
Note    Current settings appear under File conversion details at the bottom of the File Conversion 
Properties dialog box. Because some file types share the same extension, such as .doc (used for Microsoft Word
and WordPerfect files), you may need to edit the conversion settings for the .doc file type.

Related Topics
About ActiveSync file conversion 

Disable file conversion 



Disable file conversion

Files are converted automatically every time you synchronize, copy, or move information. If conversion is turned 
off, files will not be converted, and you may not be able to open or use files synchronized or copied to your 
mobile device. You may want to disable file conversion to store a file on your device that you want to move to 
another location but not view or edit on your device. To exchange information without conversion:

1 Click Options , and then click the Rules tab.

2 Click Conversion Settings.

3 Clear Convert files when synchronized, copied or moved.

Related Topics
About ActiveSync file conversion 

Change the converter for a file type 



Welcome to Microsoft ActiveSync

Microsoft ActiveSync allows you to create a partnership between your mobile device and desktop computer using
a cable, cradle, or infrared. After you create a partnership, you can synchronize your data using a modem or 
network (Ethernet) card. You can also use your existing computer to connect to other resources through 
ActiveSync. 

You can use ActiveSync to keep information up-to-date on both computers. If you make a change on one 
computer, the next time you synchronize, the change is automatically made to the corresponding information on
the other computer. No matter where you are viewing the information, you know it's up-to-date. 

If you are new to ActiveSync, consider taking the five minute ActiveSync Tour to familiarize yourself with the 
features of Microsoft ActiveSync.

Related Topics
Take the ActiveSync Tour

Synchronize with your desktop computer

Synchronize with a server



Synchronize with your desktop computer

If you have a partnership between your mobile device and desktop computer, you can use synchronization to 
keep information up-to-date on both computers. If you make a change on one computer, the next time you 
synchronize, the change is automatically made to the corresponding information on the other computer. 

After your first synchronization, you may discover that ActiveSync did not synchronize all of the information you 
expected. ActiveSync synchronizes a limited amount of information by default to conserve storage space on your
device. You may find that the amount of information provided for a given information type does not suit your 
needs. You can modify the amount of information synchronized for each information type.

By default, your device will synchronize continuously with your desktop computer. You can change the 
synchronization mode by selecting to synchronize only when you first connect or only when you manually start 
synchronization.

Though synchronization is the most convenient way to exchange information between your desktop computer 
and device, you can also share information by copying or moving a single file. In this case, any changes made to 
the file will not be automatically updated in the other location.

Even though you synchronize often with your desktop computer, you should also back up information on your 
mobile device. If for some reason you lose information on your device, you may not be able to get it all back 
through synchronization. For example, synchronization will not reinstall programs you have added to your device
or fix corrupted files.

Notes

· Information stored on a storage card will not be synchronized with your desktop computer.

· To synchronize Pocket Outlook information on your mobile device with your desktop computer, you must have
Microsoft Outlook installed on your desktop computer.

· If you use a third-party personal information manager (PIM), you can import this information into Outlook on 
your desktop computer and then synchronize the imported information with your mobile device. Alternatively,
you may be able to purchase a third-party program that can synchronize your PIM information. For more 
information on the availability of such a program, contact your PIM manufacturer.

Related Topics
About ActiveSync file conversion

About backing up and restoring information

About copying and moving files 

About modifying the amount of information synchronized 

Change synchronization mode 

Start synchronization



Select an information type for synchronization

To synchronize information, you must select the corresponding information type for synchronization.

1 Click Options .

2 Select the information type that you want to synchronize.

3 Click Settings, and then select the options you want.

4 Repeat steps 2 and 3 for each information type.

5 Connect your mobile device to your desktop computer. If a dialog box asks you to decide how to synchronize 
an item, follow the instructions on the screen.

Notes

· The AvantGo information type enables you to link to AvantGo.com, a free interactive Web service that 
provides access to personalized Web content for viewing on your device. To synchronize AvantGo channel 
information to your device, connect your desktop computer to the Internet. Then connect your device to your 
desktop computer or, if your device is already connected, click Sync. For more information about AvantGo, 
visit AvantGo.com.

· For more information on setting up synchronization for favorites, see Pocket Internet Explorer on your device. 

· After selecting the Pocket Access information type, you will be asked to select the host or device database 
information that you want to synchronize. 

Related Topics
Synchronize with your desktop computer

Synchronize with a server

Select host database information for synchronization 

Stop synchronizing an information type 



Stop synchronizing an information type

1 Click Options .

2 Clear the check box next to the desired information type. 

Related Topics
Synchronize with your desktop computer

Synchronize with a server

Select an information type for synchronization 



Start synchronization

Synchronization is started one of three ways, depending on the synchronization mode you have selected. 
Continuously while the device is connected is the default synchronization mode. Unless you have changed 
this option, it is the synchronization mode you are presently using.

Which synchronization mode do you want information about?

Continuously while the device is connected 

Only upon connection 

Manually 

Note You can stop synchronization at any time by clicking File and then Stop.

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Change synchronization mode

Synchronize only a selected information type



Synchronize continuously

To synchronize while in Continuously while the device is connected mode, connect your device to your 
desktop computer. ActiveSync will immediately synchronize and will continue to synchronize when you make a 
change on either computer.

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Change synchronization mode



Synchronize upon connection

To synchronize while in Only upon connection mode:

· Connect your device to your desktop computer. ActiveSync will immediately synchronize.

· To synchronize after the first synchronization, click Sync .

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Change synchronization mode



Synchronize manually

To synchronize while in Manually mode, click Sync .

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Change synchronization mode



Change synchronization mode

By default, ActiveSync synchronizes continuously while your device is connected to your desktop computer. You 
can also synchronize only when you first connect your device to your desktop computer or only when you initiate
the synchronization command.

1 Click Options , and then click the Sync Mode tab.

2 Select the synchronization mode you want to use.

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Start synchronization

Synchronize only a selected information type



Change the PIM used for synchronization

If you install a new personal information manager (PIM), the next time you connect your device, you will 
automatically be prompted to select a PIM as the PIM used for synchronization.

If more than one PIM was installed on your desktop computer when you created your partnership, you will need 
to create a new partnership to use the other PIM.

1 Disconnect your device and delete the partnership.

2 Reconnect your device. The New Partnership wizard will start automatically.

3 Follow the directions on the screen.

4 In the Select a Personal Information Manager dialog box, select a different PIM.

5 Follow the instructions on the screen to finish setting up your partnership. 

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Delete a partnership



Synchronize with a server

You can synchronize data between your mobile device and a server if your company has purchased and installed 
Microsoft Mobile Information Server with Microsoft Server ActiveSync.

Your personal information, such as Inbox messages and contacts, can be stored on a server, your desktop 
computer, and your mobile device. Synchronization is the process of comparing the information on your mobile 
device with the information stored on a server or your desktop computer to keep it up-to-date in both places. 
Changes made on one computer are automatically made to the corresponding information on the other 
computer. You cannot synchronize an information type with both your desktop computer and Server ActiveSync. 
For example, if you are synchronizing your Inbox with a server, you will not be able to do so with your desktop 
computer running ActiveSync.

When you synchronize with Server ActiveSync, you use your enabled device to compare the Calendar, Contacts, 
and Inbox information on your device with the information on a server and update both locations. Before you can
synchronize, you will need to configure your device using settings provided by the server administrator. 

To synchronize with a server

1 Connect your device to your desktop computer.

2 Click Tools and then Options.

3 Select the Enable synchronization with a server check box.

4 Click Configure and enter server setting information.

5 To synchronize, connect your device to your desktop computer directly or using a remote connection. If 
connecting directly synchronization will occur automatically. For directions on synchronizing remotely, see 
Connections Help on your device.

Notes

· Synchronization with a server is not supported on all devices.

· If you change your mind, you can easily change whether an information type is synchronized with your 
desktop computer or with Server ActiveSync by clicking Tools and then Options.

Related Topics
About ActiveSync file conversion

About backing up and restoring information

About copying and moving files 

Start synchronization



About modifying the amount of information synchronized

In addition to determining which information types are synchronized, you can control the amount of information 
synchronized for each information type. This is done through the synchronization settings for that information 
type. The default synchronization settings for an information type may limit the amount of information 
synchronized to your device to conserve storage space on your device. You may find that these default 
synchronization settings do not suit your needs. You can modify the synchronization settings for each information
type.

What do you want to do?

Modify AvantGo synchronization settings 

Modify Calendar synchronization settings 

Modify Contacts synchronization settings 

Modify Favorites synchronization settings 

Modify Files synchronization settings 

Modify Inbox synchronization settings 

Modify Notes synchronization settings 

Modify Pocket Access synchronization settings 

Modify Tasks synchronization settings 

Synchronize only a selected information type 

Notes    This information applies to synchronization with a desktop computer only. For more information on 
synchronization with a server, see Synchronize with a server.

Related Topics
About synchronization 

Select an information type for synchronization 



Modify Calendar synchronization settings

When the Calendar information type is selected for synchronization, ActiveSync synchronizes all upcoming 
appointments and appointments from the past two weeks each time you synchronize. To synchronize past 
appointments or only appointments in certain categories, modify the Calendar synchronization settings.

What do you want to do?

Synchronize appointments only in selected categories

Synchronize appointments within a date range 

Note    Some features supported in your personal information manager (PIM) may not be supported in Calendar. 
These features may not be synchronized or they may be incorrectly synchronized.

Related Topics
Change synchronization mode

Select an information type for synchronization 

Synchronize only a selected information type



Synchronize appointments only in selected categories

To save storage space on your device, you may want to synchronize appointments only in certain categories, 
such as business or personal.

Note    Before you can synchronize appointments based on categories, you must assign appointments to 
categories on your mobile device or desktop computer. If you create a custom category on your device, you 
must also create the category on your desktop computer.

1 Click Details .
2 Double-click Calendar and select Synchronize only those appointments in the following 

selected categories.
3 To stop synchronizing items in a certain category, clear the check box next to that category.

Related Topic
Modify Calendar synchronization settings 



Synchronize appointments within a date range

To save storage space on your mobile device, synchronize appointments within a convenient date range.

1 Click Details .
2 Double-click Calendar and select the Synchronize only the option.
3 Select the number of weeks in the past and future.

Tip    If you want to synchronize future appointments only, enter 0 for the number of weeks in the past.

Related Topic
Modify Calendar synchronization settings 

 



Modify Contacts synchronization settings

When the Contacts information type is selected for synchronization, all of your contacts will be synchronized. If 
you have a large number of contacts, synchronization may be slow and require a lot of storage space. To 
synchronize only selected contacts or only contacts in certain categories, modify the Contacts synchronization 
settings.

What do you want to do?

Synchronize selected contacts

Synchronize contacts only in selected categories

Note    Some features supported in your personal information manager (PIM) may not be supported by Contacts. 
These features may not be synchronized or may be incorrectly synchronized.

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Synchronize contacts only in selected categories

To save storage space on your device, you may want to synchronize contacts only in certain categories, such as 
business or personal.

Note    Before you can synchronize contacts based on categories, you must assign contacts to categories on your
mobile device or desktop computer. If you create a custom category on your device, you must also create the 
category on your desktop computer.

1 Click Details .
2 Double-click Contacts and then select Synchronize only those contacts in the following 

selected categories.
3 To stop synchronizing items in a certain category, clear the check box next to that category.

Related Topic
Modify Contacts synchronization settings 



Synchronize selected contacts

To save storage space, you can synchronize only specific contacts you need to keep up-to-date.

1 Click Details .
2 Double-click Contacts and then select Synchronize only the following contacts.
3 To stop synchronizing a contact, clear its check box.

Related Topic
Modify Contacts synchronization settings 



Modify Favorites synchronization settings

Once the Favorites information type is selected for synchronization, all of your favorite URLs and those Web 
pages you have marked for offline viewing in Microsoft Internet Explorer 5 will be synchronized. If you 
synchronize a large number of Web pages or synchronize images and sounds with your Web pages, 
synchronization may be slow, and a lot of storage space will be used on your device. To conserve storage space, 
synchronize Web pages without images or sounds, or only synchronize certain Web pages. Limiting the number 
of synchronized Web pages or the amount of Web page content affects only the information on your mobile 
device.

What do you want to do?

Limit synchronized Favorites information 

Stop synchronizing a favorite 

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type



Limit synchronized Favorites information 

To conserve memory on your mobile device, you can synchronize Web page text without downloading images, 
sounds, and/or video.

1 Click Details.

2 Double-click Favorites and click the Customize tab.

3 Do one or both of the following:

To stop downloading images, clear Synchronize Images.

To stop downloading sounds and video, clear Synchronize Sound.
Note    To limit the number of links down in a Web page that are synchronized with your device, right-click the 
Favorites link in the Mobile Favorites folder, and then click Properties. In the Download tab, select the number 
of links down that you want.

Related Topics
Modify Favorites synchronization settings 



Stop synchronizing a favorite

To conserve storage space on your mobile device, stop synchronizing Web pages you no longer read.

1 Click Details.

2 Double-click Favorites and click the General tab.

3 Do one of the following:

To stop synchronizing only certain Web pages, clear the check box next to the corresponding pages.

To stop synchronizing all Web pages, click Clear All.

Notes

· Updated information for the Web pages will no longer be downloaded to your mobile device, but old 
information will remain on your device. For more information on clearing the Web page information on your 
device, see Help on your device.

· To stop synchronizing Web page content while continuing to synchronize favorite links, in the Favorites 
Settings dialog box, click the Customize tab and clear Synchronize offline content pages. 

Related Topics
Modify Favorites synchronization settings 



Modify Files synchronization settings

When the Files information type is selected for synchronization, ActiveSync synchronizes all of the files you place
in a special folder. This folder was created on your desktop computer when you selected the Files information 
type for synchronization. A shortcut to the folder was placed on your desktop.

You can, for example, synchronize the following types of files:

· Excel · Pocket PowerPoint · InkWriter
· Pocket Excel · Word · Notes
· PowerPoint · Pocket Word · Note Taker

The location of this folder on your desktop computer depends on the operating system running on your desktop 
computer. If your computer is running Windows 98/2000, this folder is located in C:\My Documents\device 
name. If your computer is running Windows NT, this folder is located in C:\Winnt\Profiles\your username\
Personal\device name. Once in the folder named for your device, look for a folder called Synchronized Files or 
My Documents. The name of the folder depends on the device you are using.

What do you want to do?

Synchronize files from your desktop computer 

Synchronize files from your mobile device 

Stop synchronizing a file 

Note    If you mark a file as hidden on your desktop, delete a file, or remove the file from the Synchronized Files 
folder, the file will be deleted from your device the next time you synchronize.

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Synchronize files from your desktop computer

To synchronize a file, place it in the special folder used for synchronization. A shortcut to this file was placed on 
your desktop computer's desktop when you selected to synchronize the Files information type. The file is called 
device name Synchronized Files or device name My Documents, depending on the mobile device you are 
using.

1 Connect your device to your desktop computer.

2 Click Explore . Windows Explorer will start, and the Mobile Device window will open.

3 In Windows Explorer, browse to the file on your device or desktop computer that you want to synchronize.

4 Select the file and drag it to the Synchronized Files folder. 

Related Topics
Modify Files synchronization settings 

Synchronize files from your mobile device 



Stop synchronizing a file

If you remove a file from the Synchronized Files folder on your desktop computer or mobile device, it will be 
deleted in the corresponding location the next time you synchronize.

1 To keep a version of the file for future use, make a copy of the file and place it in a folder other than the 
Synchronized Files folder.

2 Click Details .
3 Double-click the File information type.
4 Select the file you no longer want to synchronize, and then click Remove.

Related Topic
Modify Files synchronization settings



Modify Inbox synchronization settings

When the Inbox information type is selected for synchronization, ActiveSync synchronizes the first 100 lines of 
messages sent to you within the last five days each time you synchronize. Also, only messages in the Inbox 
folder on your desktop computer are synchronized. To receive more or less content when synchronizing 
messages, modify the Inbox synchronization settings.

What do you want to do?

Synchronize the entire message

Synchronize more messages 

Synchronize message attachments

Synchronize subfolders

Notes

· Inbox synchronization with Microsoft Outlook Express is not supported.

· Inbox synchronization is not available on all devices. 

· If Inbox synchronization is available on your device you can only sync to the default Microsoft Outlook e-mail 
store.

· If during the first synchronization of Inbox information you combine information on your device and desktop 
computer and then later stop Inbox synchronization, messages may be permanently registered as unresolved 
items. To delete unresolved items, save important files, delete the partnership, and then create a new 
partnership.

· E-mail addresses synchronized from your desktop computer may not always appear on your mobile device in 
the common Internet format. Depending on the e-mail system you use, e-mail addresses may appear in that 
system’s default format.

Related Topics
About partnerships 

Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Synchronize the entire message

To conserve storage space on your device, ActiveSync only synchronizes the first 100 lines of your e-mail 
messages. If you expect to receive longer messages often, change the line maximum.

1 Click Details .
2 Double-click Inbox and then select To save space, copy at most. 
3 In the Lines box, double-click the number of lines and then enter a new number.

Related Topic
Modify Inbox synchronization settings 



Synchronize more messages

To conserve storage space on your device, ActiveSync synchronizes only the last five days of e-mail messages. 
To synchronize more messages, increase the number of days.

1 Click Details .
2 Double-click Inbox, select Copy messages from the last, and increase the number of days.

Related Topic
Modify Inbox synchronization settings 



Synchronize message attachments

1 Click Details .
2 Double-click Inbox and select Include file attachments.
3 To limit the size of synchronized attachments, select Limit attachment size to and enter a size 

limit. Attachments larger than this limit will not be synchronized with your device.

Notes

· Only mail services connected to IMAP4 servers can accept messages as attachments.

· To receive meeting requests, your network administrator must select the Use Microsoft Exchange rich-
text format option on the Exchange server. This option enables Transport Neutral Encapsulation Format 
(TNEF). If TNEF is enabled, it will take longer to download messages, and you won’t be able to receive e-mail 
messages as attachments.

Related Topic
Modify Inbox synchronization settings 



Synchronize subfolders

1 Click Details .
2 Double-click Inbox.
3 Select desired folders.

Note    Synchronization of subfolders is not supported on all devices.

Related Topic
Modify Inbox synchronization settings 



Modify Notes synchronization settings

Notes can be synchronized between your desktop computer and device either through notes synchronization or 
file synchronization. Notes synchronization synchronizes the notes on your device with Outlook Notes on your 
desktop computer. File synchronization synchronizes all notes on your device with the device name My 
Documents folder on your desktop computer. For more information on file synchronization, see Modify Files 
synchronization settings. 

To synchronize your notes through notes synchronization, first select the Notes information type for 
synchronization in ActiveSync. The next time you synchronize, all of the notes in My Documents and its subfolder
on your device will appear in Outlook Notes on your desktop computer. Notes that contain only text will appear 
as regular notes in Outlook on your desktop computer, while notes containing written text or drawings will 
appear in the device format. In addition, all notes in the main Outlook folder on the desktop computer will 
appear in Notes on the device.

Note    If you synchronize your notes using file synchronization and then later decide to use notes 
synchronization, all of your notes will be synchronized with Outlook on your desktop computer and will no longer 
be stored in the device name My Documents folder.

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Select an information type for synchronization 



Modify Pocket Access synchronization settings

When you selected the Pocket Access information type for synchronization, you were asked to select the host 
database and/or mobile device database information you wanted synchronized. By default, ActiveSync 
synchronizes all tables in the database and all fields within those tables. To add databases for synchronization, 
change the tables and fields synchronized from a database, or stop synchronizing databases, modify the Pocket 
Access synchronization settings.

What do you want to do?

Change the fields and tables synchronized from a database 

Select host database information for synchronization 

Select mobile device database information for synchronization 

Stop synchronizing a database 

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Change the fields and tables synchronized from a database

1 Click Details .
2 Double-click Pocket Access.
3 Select the database that contains the fields and tables you want to change, and then click 

Properties.
4 Select or clear fields and tables for synchronization.

Related Topic
Modify Pocket Access synchronization settings 



Select host database information for synchronization

You can synchronize up to 65,536 records from a host database with your device. 

1 Click Details .
2 Double-click Pocket Access.
3 Click Add, and select the database. To synchronize information other than Access database 

information, select ODBC Database from the File of type list. An ODBC database must already be set up as an 
ODBC data source.

4 Click Open. ActiveSync places the database information in the My Documents folder on your 
device.

Notes

· You can also synchronize Access (.mdb) database information with your mobile device by dragging the .mdb 
file onto your device icon in the Mobile Devices window.

· If two databases with the same file name and at least one table with the same name exist on both computers,
you must choose Overwrite existing tables and/or data. Otherwise, ActiveSync will not download 
information. Also, always select to synchronize the table with the most data to ensure data isn’t lost.

· To access a SQL Server using a dial-up connection to a network or an Ethernet connection, your system 
administrator must set up the ODBC SQL Server so that it has a trust relationship with the SQL Server. 
Otherwise, database information will not be updated on your device during synchronization.

· Windows CE Store information can’t be synchronized, but you can copy the information from your device to 
your desktop computer.

Related Topic
Modify Pocket Access synchronization settings 



Select mobile device database information for synchronization

1 Connect your device to your desktop computer.

2 Click Explore . Windows Explorer will start, and the Mobile Device window will open.

3 In Windows Explorer, double-click the My Documents folder.

4 Drag and drop the database from your device to the desktop on your desktop computer. ActiveSync will 
convert the information and place it in the \Program Files\ActiveSync\Profiles\device name folder. The file will
be named dbx.mdb. To synchronize information to another type of database other than an Access database, 
in the Export from Mobile Device to Database dialog box, click Browse. Select the database and select 
ODBC Database in the File of type list. An ODBC database must already be set up as an ODBC data source.

Related Topic
Modify Pocket Access synchronization settings 



Stop synchronizing a database

1 Click Details .
2 Double-click Pocket Access.
3 Select the database you want to stop synchronizing, and click Remove.

Related Topic
Modify Pocket Access synchronization settings 



Modify Tasks synchronization settings

If you have a large number of tasks, synchronization may be slow and use a lot of storage space. Therefore, by 
default, only incomplete tasks are synchronized. To synchronize all tasks or tasks in certain categories, modify 
the Tasks synchronization settings.

What do you want to do?

Synchronize tasks only in selected categories

Synchronize only incomplete tasks

Synchronize active tasks within a date range 

Notes

· Some features supported in your personal information manager (PIM) may not be supported in Tasks. These 
features may not be synchronized or may be synchronized incorrectly.

· A task request that has been deleted on your device and then synchronized with your desktop computer will 
not cause Outlook to send a cancellation notice.

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Synchronize tasks only in selected categories

To save storage space on your device, you may want to synchronize tasks only in certain categories, such as 
business or personal.

Note    Before you can synchronize tasks based on categories, you must assign tasks to categories on your 
mobile device or desktop computer. If you create a custom category on your device, you must also create the 
category on your desktop computer.

1 Click Details .
2 Double-click Tasks and select Synchronize only those tasks in the following selected 

categories.
3 To stop synchronizing items in a certain category, clear the check box next to that category.

Related Topic
Modify Tasks synchronization settings 



Synchronize only incomplete tasks

1 Click Details .
2 Double-click Tasks and select Synchronize only incomplete tasks.
3 Select the number of weeks you want to synchronize in the past and future.

Tip    If you want to synchronize future tasks only, enter 0 for the number of weeks in the past.

Related Topic
Modify Tasks synchronization settings 



Synchronize active tasks within a date range

To save storage space on your mobile device, synchronize active tasks within a convenient date range.

1 Click Details .
2 Double-click Tasks and select the Synchronize only the option.
3 Select the number of weeks in the past and future.

Tip    If you want to synchronize future tasks only, enter 0 for the number of weeks in the past.

Related Topic
Modify Tasks synchronization settings 



Synchronize only a selected information type

Instead of doing a full synchronization that synchronizes all selected information types, you can synchronize a 
single information type. For example, you may want to synchronize your e-mail messages before leaving the 
office, but you don’t want to wait for a full synchronization.

1 Click Details .
2 Select an information type.
3 Right-click the selected information type, and then click Synchronize Selection.

Related Topics
Synchronize with your desktop computer 

Synchronize with a server

Change synchronization mode

Start synchronization 



Modify AvantGo synchronization settings

When you select the AvantGo information type for synchronization and then connect your device to your desktop
computer, AvantGo and ActiveSync automatically configure the necessary Internet settings, including port and 
proxy settings. 

Although you should not need to change any of the AvantGo settings, you can do so by double-clicking 
AvantGo. For information on a specific setting, click the question mark in the upper-right corner of the dialog 
box, and then click an option.

For more information about AvantGo, visit AvantGo.com.

Note    To initiate AvantGo synchronization, reconnect your device to your desktop computer or click Sync.

Related Topics
Change synchronization mode

Select an information type for synchronization

Synchronize only a selected information type 



Connect to ActiveSync using a cable or a cradle

Use a cable or cradle to establish a direct link between your mobile device and desktop computer. When creating
a partnership, you must connect using a cable, cradle, or infrared connection. 

The cable or cradle used to connect your device to your desktop computer may use a serial cable or USB cable. 
Serial cable connections can be used with desktop computers running any type of Windows operating system. 
USB cable connections cannot be used with desktop computers running Windows NT.

Always use the cable or cradle provided by your device’s manufacturer to connect your device to your desktop 
computer.

To use a cable or a cradle

{button ,AL(`aserial1',1,`',`second')}    Step 1    Switch to the serial port on your device 

{button ,JI(`peg.HLP>second',`Step_2_Connect_using_a_serial_cable_or_a_cradle')}    Step 2    Connect using a 
cable or a cradle 



Step 1 is the Switch to the Serial Port topic in gryphon.doc, rapier.doc, and jupiter.doc.



Step 2    Connect using a cable or a cradle

1 Plug one end of the cable into the COM port or USB port on your desktop computer. 

2 Plug the other end into your mobile device. ActiveSync connects automatically to your device.
Note    If you are using a serial cable, the COM port you used during installation of ActiveSync must be available 
(not in use) for ActiveSync to connect to your device. If you have freed the COM port for other uses, on the File 
menu, click Get Connected. ActiveSync will free the COM port and connect to your device.

Related Topics
Connect to ActiveSync using a cable or a cradle 

Working with COM ports



Connect to ActiveSync using infrared

Use an infrared connection to quickly create a direct connection between your mobile device and desktop 
computer. Simply align the infrared ports and initiate the connection from your device. This method is ideal for 
quickly switching between multiple devices since there are no cables or adapters to change. Also, when creating 
a partnership, you must connect using infrared, a cable, or a cradle connection.

To use an infrared connection

{button ,JI(`peg.HLP>second',`Step_1_Set_up_an_infrared_connection')}    Step 1    Set up an infrared connection 

{button ,JI(`peg.HLP>second',`Step_2_Switch_to_the_infrared_port_on_your_Pocket_PC_b')}    Step 2    Switch to 
the infrared port on your desktop computer 

{button ,AL(`ainfrared3',1,`',`second')}    Step 3    Connect to your device using infrared 



Step 1    Set up an infrared connection

· Install and configure an infrared port on your desktop computer following the manufacturer’s instructions.
Note    For information about infrared drivers, see the Windows CE Web site at 
http://www.microsoft.com/windowsce.

What’s next?

{button ,JI(`peg.HLP>second',`Step_2_Switch_to_the_infrared_port_on_your_Pocket_PC_b')}    My infrared 
connection is set up. Go to step 2. 



Step 2 is Switch to the Infrared Port and step 3 is Connect using infrared.    Both of these topics are listed in 
gryphon.doc, rapier.doc, and jupiter.doc.



Connect to ActiveSync using a modem

With a modem connected to your device and network Remote Access Service (RAS) server access to your 
desktop computer, you can establish a connection through a network to your desktop computer.

Before you begin

· Set up a partnership between your device and desktop computer using a cable, cradle, or infrared connection.

· Ask your network administrator to set up a RAS account. Also, ask for the phone number and password to the 
RAS server.

· Install or attach an internal modem, modem card, or external modem for your mobile device.

To connect using a modem

{button ,JI(`peg.HLP>second',`Step_1_Enable_a_network_connection_in_ActiveSync')}    Step 1    Enable a 
network connection in ActiveSync 

{button ,AL(`amodem2',1,`',`second')}    Step 2    Set up a modem connection on your device 

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_modem')}    Step 3    Connect using a modem 

Related Topics
About partnerships 

Connect to ActiveSync using a cable or a cradle 

Connect to ActiveSync using infrared 



Step 1    Enable a network connection in ActiveSync

1 On the File menu, click Connection Settings. 

2 Select Allow network (Ethernet) and Remote Access Service (RAS) server connection with this 
desktop computer.

What’s next?

{button ,AL(`amodem2',1,`',`second')}    The connection is set up on my desktop computer. Go to step 2. 



Step 2 is “Set up a modem connection on your device” and is located in gryphon.doc, rapier.doc and jupiter.doc. 
Step 3 is “Connect using a modem connection” from earlier in this file.



Step 3    Connect using a modem

1 If you are using a modem on your desktop computer, ensure the modem is turned on before you leave.

2 Leave your desktop computer on and logged on as you were when you created the partnership.

3 Ensure your personal information manager (PIM) and e-mail program (Microsoft Outlook or Microsoft 
Exchange) are running.

4 Once you are on the road, follow the directions in Help on your device for connecting using a modem, or dial-
up, connection. For more information, see Communications or Connections Help on your device.

Caution    You may need to use external (AC) power while using the modem with your device.

Notes

· Test the connection before leaving, and take the phone number for the modem or RAS account with you.

· If you receive an error message on your device that states an information type needs attention, or if 
unresolved items are reported after synchronization, you need to synchronize directly with your desktop 
computer using a cable, cradle, or infrared connection.

Related Topics
About partnerships 

About unresolved items 

Connect to ActiveSync using a modem 

Connect to ActiveSync using a cable or a cradle

Connect to ActiveSync using infrared 



Connect to ActiveSync using a network (Ethernet) card

With an Ethernet card for your device, you can connect to a LAN (local area network) on which you have an 
account. Connect using an Ethernet card when you have access to the LAN and you want to synchronize, copy, 
or move information while you are away from your desktop computer.

Before you begin

· Set up a partnership, between your device and desktop computer using a cable, cradle, or infrared 
connection.

· Purchase an NE2000-compatible Ethernet card.

To use a network (Ethernet) connection

{button ,JI(`peg.HLP>second',`Step_1_Enable_a_network_Ethernet_connection_in_ActiveSync')}    Step 1    Enable
a network (Ethernet) connection in ActiveSync 

{button ,AL(`aethernet2',1,`',`second')}    Step 2    Install an Ethernet card in your device 

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_network_Ethernet_connection')}    Step 3    Connect using
a network (Ethernet) connection 

Related Topics
About partnerships 

Connect to ActiveSync using a cable or a cradle 

Connect to ActiveSync using infrared 



Step 1    Enable a network (Ethernet) connection in ActiveSync

1 On the File menu, click Connection Settings. 

2 Select Allow network (Ethernet) and Remote Access Service (RAS) server connection with this 
desktop computer. 

What’s next?

{button ,AL(`aethernet2',1,`',`second')}    The connection is set up. Go to step 2. 



Step 2 is Install a NE2000 Compatible Ethernet card on your device” in the gryphon.doc, rapier.doc and 
jupiter.doc files.



Step 3    Connect using a network (Ethernet) connection

1 Leave your desktop computer on and logged on as you were when you created the partnership.

2 Ensure your personal information manager (PIM) and e-mail program (Microsoft Outlook or Microsoft 
Exchange) are running.

3 Once you are away from your desktop computer, follow the directions in Help on your device for connecting 
using a network (Ethernet) connection. For more information, see Communications or Connections Help on 
your device.

Related Topics
About partnerships 

Connect to ActiveSync using a network (Ethernet) card 



Connect to a network or the Internet through ActiveSync

Use ActiveSync to pass through this computer to a network or the Internet to perform tasks such as downloading
IMAP 4 e-mail messages, or browsing the Internet on your mobile device. 

1 Click Options.

2 On the Rules tab, select Open ActiveSync when my mobile device connects.

3 From the Connections list, select what this computer should be connected to when passing through 
ActiveSync to other locations.

Note    The ability to use ActiveSync to pass through this computer is not supported on all devices.

Related Topics
About partnerships 

Connect to ActiveSync using a cable or a cradle 

Connect to ActiveSync using infrared 
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AC adapter

A connector that provides external (not battery) power to your mobile device. For information about installation 
and usage, see your device manufacturer’s documentation.



ActiveSync

A program that manages synchronization between your mobile device and desktop computer.



backup file

A file containing the program information on your mobile device. This file does not include information stored in 
ROM, such as settings and factory-installed software.



baud rate

The speed at which a modem transmits data. 



cable connection

A communications method by which you use a cable to connect your mobile device to another device.



category

A keyword you create to organize items in Calendar, Contacts, and Tasks on your mobile device. You can use 
categories to easily find, sort, filter, or group items. If the personal information manager (PIM) program on your 
desktop computer supports categories, you can synchronize items in categories.



channel

A Web site designed to deliver content from the Internet to your desktop computer. You can subscribe to Mobile 
Channels, which you can then download to your mobile device during synchronization. Not all mobile devices are
capable of displaying channel content.



clear memory

A process that erases all information stored in RAM on your mobile device. For more information, see your device
manufacturer’s documentation.



CompactFlash card

A modem, network, or storage card that you plug into your mobile device.



COM port

A serial communications port used to connect a device, such as a modem, printer, or mobile device, to your 
desktop computer.



conflict

An item that has been changed on both your mobile device and desktop computer. For example, if you change 
Bob Jones’s title to be "Treasurer" on your device, then change his company name to "XYZ Widgets" on your 
desktop computer, the Bob Jones contact will cause a conflict the next time you synchronize.



conflict resolution

A process that enables you to view an item that has been changed on both your desktop computer and mobile 
device, and select which version of the item you want to keep.



connection

The ability to interact with another device, computer, network, or the Internet by means of a serial cable, 
infrared, modem, or network (Ethernet) card.



cradle

Hardware provided by your mobile device manufacturer that is connected via a serial cable to your desktop 
computer. The device is placed in the cradle to connect to your desktop computer.



desktop computer

A personal computer (desktop or laptop) running Microsoft Windows 98/2000 or Windows NT to which you 
connect your mobile device.



external modem

A stand-alone modem that is connected by a serial cable to a desktop computer or mobile device.



Favorites

A list of favorite Web sites accessed from the Favorites menu in Internet Explorer and Pocket Internet Explorer.



file conversion

A process of converting Windows-compatible files on your desktop computer to Windows CE-compatible files on 
your mobile device, and vice versa.



guest

A mobile device that has a temporary connection, instead of a partnership, with the desktop computer. 
Information can be copied, moved, and backed up between a guest device and the desktop computer, but 
information cannot be synchronized. Once a guest device is disconnected from the desktop computer, file 
conversion settings for the guest device are deleted.



host database

The database containing the source data used to create or synchronize with another database. The host 
database can be a Microsoft Access database (*.mdb), a SQL Server database, or other ODBC-compliant 
database located on your desktop computer, your mobile device, or a server. For example, you can use a SQL 
Server database as the host database to create and synchronize with a Pocket Access file (*.cdb) on your device.



IMAP4 (Internet Message Access Protocol 4)

A set of rules and conventions an e-mail program uses to access e-mail and bulletin board messages stored on 
an e-mail server and retrieve or display them on a computer. Not all e-mail servers use IMAP4.



information type

Information grouped by type for the purpose of synchronization. Once an information type is selected for 
synchronization, the items in that group are synchronized based on your synchronization settings and 
synchronization mode. For example, the Calendar information type synchronizes your appointments and other 
information contained in Calendar on your device with corresponding information in Microsoft Outlook on your 
desktop computer.



infrared (IR) connection

A communications method by which you connect your mobile device to another device (such as another mobile 
device, your desktop computer, or a printer) using the IR ports on each device.



mobile desktop component

Channel content that is formatted specifically for display on the Active Desktop of a mobile device. Not all 
devices are capable of displaying mobile desktop components.



mobile device

A small computer running Microsoft Windows CE.



modem card

A card that you plug into your mobile device to connect to a phone line.



modem connection

A connection between your mobile device and a remote computer or network that is established using a modem 
installed on your device. 



network card

A card that you plug into your mobile device to connect to a local area network.



partnership

A file that enables a device to synchronize with a desktop computer. This file contains the synchronization and 
file conversion settings you select on both your mobile device and desktop computer. This file is stored on your 
desktop computer. An additional file that enables your desktop computer to recognize your device is stored on 
your mobile device.



PC Card

A modem, network, or storage card that you plug into your mobile device. This card conforms to the PCMCIA 
specification.



PC Link

A program on your mobile device that is used to initiate an infrared connection.



personal information manager (PIM)

A program that stores and organizes information such as appointments, contacts, and tasks.



POP3 (Post Office Protocol 3)

A set of rules and conventions supported by most mail servers that enables you to retrieve and view e-mail on 
your computer.



PPP (Point-to-Point Protocol)

The set of rules and conventions that your mobile device uses to communicate with your Internet service 
provider’s network server.



Remote Access Service (RAS) account

A network account that enables your mobile device to remotely access a network.



Remote Access Service (RAS)

Windows software that is installed on network servers and enables remote access to a network server by using a 
modem attached to your device.



remote connection

Any connection that connects your mobile device to a remote computer or network. Typically, a remote 
connection is established using a modem or network (Ethernet) connection.



Remote Networking

A communications program located on the mobile device used to create, store, and establish modem 
connections to remote computers and networks.



reset

The process that causes your device to restart. For more information, see your device manufacturer’s 
documentation.



restore

The process of replacing information on your mobile device with information contained on a backup file.



resolve items

A process that enables you to view an item that could not be synchronized and, in some cases, decide how to 
correct the error or conflict that is preventing synchronization.



serial cable

A cable provided by your manufacturer to connect your mobile device to your desktop computer through a COM 
port.



subscription

A setting whereby Internet Explorer automatically checks your channel or favorite Web page for new content and
then either notifies you or downloads the updated content. You must first subscribe to the information in Internet
Explorer on your desktop computer. Then, download the information to your mobile device during 
synchronization.



synchronization

The process where ActiveSync compares information on your mobile device with the corresponding information 
on your desktop computer and then updates either computer with the latest information.



synchronization mode 

A setting that determines when synchronization occurs. You can choose one of three synchronization modes: 
continuously while the device is connected, only upon connection, and manually.



synchronization settings 

The settings that determine the amount of information synchronized for each information type on your mobile 
device. For example, the synchronization settings for the Inbox information type determine how many days of 
messages are synchronized, how many lines of each message are synchronized, and whether attachments are 
synchronized.



TCP/IP (Transmission Control Protocol/Internet Protocol)

The set of rules and conventions that your mobile device uses to communicate remotely with ActiveSync.



unresolved items

Items that cannot be synchronized due to synchronization conflicts.



USB (universal serial bus) cable

A cable provided by your manufacturer to connect your mobile device to your desktop computer through a 
universal serial bus.



Windows CE

An operating system specially designed for mobile devices. Windows CE is similar to other Microsoft Windows 
operating systems, such as Windows 98.



About partnerships

During installation of Microsoft ActiveSync, you were prompted to create a partnership with your mobile device. 
When you set up a partnership, you select synchronization and file conversion settings, which are contained in a 
file on your desktop computer. This file enables your desktop computer to recognize your device. Only devices 
that have a partnership with a desktop computer can synchronize information between the two computers.

Partnerships are stored in ActiveSync and have the same name as the corresponding device. Your desktop 
computer can set up partnerships with many different mobile devices, but a device can have partnerships with 
only two computers.

Having two partnerships enables you to share your personal information software (PIM) and other information 
among three computers. For example, you can keep the same contact information on your desktop computer at 
work, your desktop computer at home, and your device. No matter where you are viewing information, you will 
have the information you want at your fingertips. However, you can synchronize e-mail messages with your 
device and one desktop computer only.

Related Topics
About working as a guest 

Delete a partnership

Set up a partnership with one desktop computer

Set up partnerships with two desktop computers



Set up a partnership with one desktop computer

The first time you connected your mobile device to your desktop computer, you were asked to set up a 
partnership. This partnership allows you to synchronize information with your device. Though your device can 
have partnerships with two desktop computers, e-mail messages can be synchronized with only one desktop 
computer. 

1 Connect your mobile device to your desktop computer. The New Partnership wizard will start automatically.

2 Follow the directions on the screen.

3 If your device already has a partnership with another desktop computer and you no longer want to use it, in 
the Select Number of Partnerships dialog box, select Yes, I want to synchronize with only this 
computer. The other partnership will be removed from your device, and the former desktop computer will no 
longer recognize the device.

4 Follow the directions on the screen.

Related Topics
About partnerships

Connect to ActiveSync using a cable or a cradle 

Connect to ActiveSync using infrared 

Delete a partnership

Set up partnerships with two desktop computers



Set up partnerships with two desktop computers

To ensure that synchronization functions properly, the two desktop computers must be configured with the same 
synchronization settings. For example, you should synchronize the same types of information using the same 
synchronization settings on both desktop computers. Both desktop computers should also use the same personal
information manager (PIM). 

1 If your device already has a partnership with a desktop computer, go to step 4. Otherwise, connect your 
mobile device to the first desktop computer using a cable or infrared connection. The New Partnership wizard 
will start automatically.

2 Follow the directions on the screen. 

3 After you have set up a partnership and synchronization is complete, disconnect your device from the first 
computer.

4 Connect your device to the second desktop computer using a cable or infrared connection. The New 
Partnership wizard will start.

5 Follow the directions on the screen.

6 In the Select Number of Partnerships dialog box, select No, I want to synchronize with two 
computers.

7 Follow the directions on the screen.

Notes

· You will not be able to maintain separate schedules in the PIM on the two desktop computers. For example, 
your business appointments will be displayed on your home computer.

· You will not be able to synchronize Inbox information between the desktop computers and your device.

Related Topics
About partnerships 

About synchronization 

Delete a partnership

Set up a partnership with one desktop computer



Delete a partnership

Deleting a partnership deletes all of the synchronization and file conversion settings you have chosen for that 
mobile device. Note, however, that backup files for the device will not be deleted.

1 Disconnect your device from your desktop computer.

2 On the File menu, click Mobile Device.

3 Select the device with the partnership you want to delete.

4 On the File menu, click Delete Partnership.

Related Topics
About partnerships 

Set up a partnership with one desktop computer

Set up partnerships with two desktop computers



About working as a guest

You may not always want to set up a partnership to connect your mobile device to a desktop computer. For 
example, you may want to connect your device to a desktop computer to copy a file to your device. However, 
you do not want to synchronize information or do not plan to connect to the desktop computer on a regular 
basis. In such a case, set up your device as a guest.

While working as a guest, information can be copied or moved between your device and the desktop computer, 
you can back up the information on your device, and you can add programs to your device. However, you cannot
synchronize information between a guest device and a desktop computer.

A guest device only has a temporary connection with a desktop computer. Once the guest device is disconnected
from the desktop computer, settings for the guest device, such as back up and conversion settings, are deleted. 
The next time the device connects to the desktop computer, you will again need to set it up as a guest device 
with the desktop computer.

Related Topics
About partnerships 

Work as a guest 



Work as a guest

When working as a guest, you can browse the files on your mobile device and copy or move information, but you
cannot synchronize information. Once you disconnect your device from the desktop computer, settings selected 
in ActiveSync for the guest device are deleted.

1 Connect your device to the desktop computer. The New Partnership wizard will start automatically.

2 When asked if you want to set up a partnership, select No.

Related Topics
About synchronization 

Browse files on a mobile device 

Copy a file 

Move a file 



About unresolved items

If a problem or conflict occurs when an item is synchronized, it will be marked as unresolved in ActiveSync and 
on your device. You can resolve items at your convenience.

ActiveSync may not be able to synchronize an item for many different reasons. For example, if you are trying to 
access your Microsoft Outlook information and the server you are trying to connect to is unavailable, ActiveSync 
will not be able to synchronize your Calendar, Contacts, Tasks, or Inbox items.

Or a conflict could occur because an item has been changed on both your mobile device and your desktop 
computer. For example, you have lunch with Bob Jones, and during lunch he mentions his job title has changed 
to "Treasurer." You quickly make this change on your device. As soon as you get back to your office, but before 
you have had a chance to synchronize, Bob calls and tells you his company recently changed its name to "XYZ 
Widgets." Since you are at your office, you update this information on your desktop computer. The two versions 
of the Bob Jones contact will conflict with each other the next time you synchronize and will be registered as an 
unresolved item.

You can modify your conflict resolution settings so that ActiveSync does not register conflicts as unresolved 
items. Instead, you select the device or desktop computer as the default version, and ActiveSync will 
automatically replace the information on the other computer. 

Related Topics
Modify conflict resolution settings

Resolve items



Modify conflict resolution settings

To avoid resolving conflicts manually, you can set your conflict resolution settings so that ActiveSync always uses
the version on your mobile device or desktop computer.

1 Click Options  and then click the Rules tab.

2 Under Conflict Resolution, select a setting.

Related Topics
About unresolved items

Resolve items



Resolve items

During synchronization, items that cannot be synchronized without your assistance are marked as unresolved 
items in ActiveSync and on your mobile device.

1 Connect your device to your desktop computer and synchronize.

2 If you have unresolved items, on the Tools menu, click Resolve items.

3 Follow the directions on the screen. Dialog boxes presented to resolve items differ, depending on the reason 
why the item could not be synchronized.

Related Topics
About unresolved items

Modify conflict resolution settings



About copying and moving files

Using Microsoft ActiveSync, you can copy or move information from the desktop to the device and vice versa. 
Changes you make to the information on one computer will not affect the information on the other computer. If 
you want to automatically update information on both your device and desktop computer, synchronize the 
information instead.

You can copy and move two types of information to your device: files and Pocket Access Windows CE Store 
information. The procedures for moving each of these types of information are different. If you have a Windows 
CE Store table you want to view in Access on your desktop computer, copying or moving it is your only option.

Related Topics
About ActiveSync file conversion

About synchronization 

Browse files on a mobile device 

Copy a file

Copy Windows CE Store information

Move a file



Copy a file

Copying a file results in separate versions of a file on your mobile device and desktop computer. Since the files 
are not synchronized, changes made to one file will not affect the other. Note that performing these steps for an 
Access or Pocket Access file results in synchronization.

1 Connect your device to your desktop computer. 

2 In ActiveSync, click Explore . Windows Explorer will open the Mobile Device window for your device.

3 In Windows Explorer, browse to the file that you want to copy on your device or desktop computer.

4 Do one of the following:
To copy the file to your device, right-click the file and click Copy. Place the cursor in the desired folder for 
your device, right-click, and click Paste. 

To copy the file to your desktop computer, right-click the file and click Copy. Place the cursor in the desired 
folder for your desktop computer, right-click, and click Paste.

Related Topics
About copying and moving files

Copy Windows CE Store information

Move a file



Move a file

Moving a file removes it from its original location.

1 Connect your device to your desktop computer. 

2 In ActiveSync, click Explore . Windows Explorer opens the Mobile Device window for your device.

3 In Windows Explorer, browse to the file that you want to move from your device or desktop computer.

4 Right-click the file and then click Cut.

5 Browse to the folder in which you want to place the file.

6 Right-click and then click Paste.

Related Topics
About copying and moving files

Copy a file



Copy Windows CE Store information

If you create a table in Pocket Access without first creating a database, the table will be placed in the Windows 
CE Store. Windows CE Store information can be copied to your desktop computer but not synchronized. 

1 On the Tools menu, click Export Database Tables.

2 Select the check boxes for the tables that you want to copy, and clear the remaining check boxes. ActiveSync 
will convert the information and place it in the \Program Files\Microsoft ActiveSync\Profiles\device name 
folder. The file will be named dbx.mdb.

Related Topics
About copying and moving files

Copy a file



Browse files on a mobile device

Using ActiveSync, you can view the files on your mobile device.

1 Connect your device to your desktop computer.

2 In ActiveSync, click Explore . Windows Explorer will open the Mobile Devices folder.

3 In Windows Explorer, browse the files on your device as you would in any Explorer window. 
Note    When you double-click a folder in the Mobile Devices folder, it may take a few seconds for the folder to 
open.

Related Topic
About copying and moving files



About adding and removing programs

Software and programs added to your device at the factory are stored in ROM (read-only memory). You can’t 
remove or modify this software, and you’ll never accidentally lose ROM contents. Programs and data files added 
to your device after factory installation are stored in RAM (random access memory). You can install any program 
created for your device, as long as your device has enough storage space. The most popular place to find 
software for your device is on the World Wide Web. Try searching on the keyword “Windows CE” and visit some of
the Windows CE software download sites.

Related Topics
Add a program

Remove a program



Add a program

You’ll need to install the appropriate software for your device on your desktop computer before installing it on 
your device.

1 Determine your device and processor type. For more information, see the documentation that came with your
device and Help on your device.

2 Download the program to your desktop computer (or insert the CD or disk that contains the program into your
desktop computer). You may see a single *.exe file, a *.zip file, a Setup.exe file, or several versions of files for 
different device types and processors. Be sure to select the program designed for your device and processor 
type.

3 Read any installation instructions, Read Me files, or documentation that comes with the program. Many 
programs provide special installation instructions.

4 Connect your device and desktop computer.

5 Double-click the *.exe file.

· If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the 
software has been installed on your desktop computer, the installer will automatically transfer the 
software to your device. 

· If the file is not an installer, you will see an error message stating that the program is valid but it is 
designed for a different type of computer. You will need to move this file to your device. If you cannot find
any installation instructions for the program in the Read Me or documentation, use ActiveSync to copy 
the program file to the Program Files folder on your device.

Related Topics
About adding and removing programs

Copy a file

Remove a program



Remove a program

You can remove a program from your device only, or from your device and desktop computer. Removing the 
program only from your device enables you to easily add it at a later date since the program will not need to be 
added to the desktop computer.

1 Connect your device to your desktop computer.

2 On the Tools menu, click Add/Remove Programs.

3 Do one of the following:

To remove a program from your device, clear its check box.

To remove a program from both your device and desktop computer, select it and click Remove.

Notes

· If the check box for the program is dimmed, you must use Remove and remove the program from both your 
device and desktop computer. 

· If the program is not listed, you must delete it from your device. For more information on deleting files from 
your device, see Help on your device.

Related Topics
About adding and removing programs

Add a program



 ActiveSync Troubleshooter

Up-to-date troubleshooting information is available on the Web:

Connection troubleshooter: http://support.microsoft.com/support/pocketpc/tshoot/activesync/default.asp.

Synchronization troubleshooter: http://support.microsoft.com/support/tshoot/pocketpcsync.asp.



For information about creating a partnership, see About Partnerships.

For information about synchronizing data between your device and a server, see Synchronize with a Server.



Working with COM ports

To connect your mobile device to your desktop computer using a serial cable, cradle or infrared, Microsoft 
ActiveSync uses a COM port. You selected this COM port the first time you connected your device. You can use 
the same COM port for each device you connect using ActiveSync.

If you have a second COM port, you may want to use that COM port for a device (such as a digital camera) that 
does not connect to ActiveSync. If you have to share a COM port with a device that has a different connectivity 
program, you will need to free the COM port from ActiveSync before using the COM port for the other device. The
next time you want to connect a device to ActiveSync, you will need to assign the COM port back to ActiveSync.

Related Topics
Assign a COM port for ActiveSync 

Free a COM port from ActiveSync 



Free a COM port from ActiveSync

1 Connect the other type of device, such as a digital camera, to your desktop computer.

2 In the Device Not Recognized dialog box, click Disconnect COM Port.

3 The COM port is now available. If the other device still cannot connect with your desktop computer, you may 
need to assign the COM port to the other device through the other device's connectivity program. For more 
information, see the documentation that came with that device.

Note    If the Device Not Recognized dialog box is not displayed, free the COM port in the Connection 
Settings dialog box. On the File menu, click Connection Settings. Clear Allow serial cable or infrared 
connection to this COM port.

Related Topic
Assign a COM port to ActiveSync 

Working with COM ports 



Assign a COM port to ActiveSync

1 Disconnect the other device, such as a digital camera, from your desktop computer. You may need to free the 
COM port through the other device's connectivity program. For more information, see the documentation that 
came with that device.

2 Connect your mobile device to your desktop computer.

3 In ActiveSync, click File and then Get Connected.

4 Follow the directions on the screen.

Related Topic
Free a COM port from ActiveSync 

Working with COM ports 



The following topic does not appear in the Table of Contents, and no topics link to it.    It is only accessible from 
the Index and Find tabs.



Change the size of the toolbar icons

1 In ActiveSync, click View and then Toolbar.

2 Do one of the following:

To view large icons, select Large Icons 

To view small icons, select Small Icons. 

To hide icons, select None.



Connection steps 



Step 1    Switch to the serial port on your Handheld PC

The serial port is the default COM port on your Handheld PC. If you have switched COM ports to use an infrared 
connection, you will need to switch back to the serial port to connect using a cable.

1 Select Start, Settings, and then Control Panel. 

2 Double-click or double-tap the Communications icon, and then select the PC Connection tab.

3 Select Change.

4 In the Connect to desktop computer using list, select Serial Port @ 19200. For a faster connection, 
select Serial Port @ 57600.

5 Connect the cable to your device and desktop computer.

What’s next?

{button ,JI(`peg.HLP>second',`Step_2_Connect_using_a_serial_cable_or_a_cradle')}    My device is using the 
serial port. Go to step 2. 



Step 2    Switch to the infrared port on your Handheld PC

The serial port is the default COM port on your Handheld PC. To use the infrared port, you must change the COM 
port on your Handheld PC.

1 Select Start, Settings, and then Control Panel. 

2 Double-click or double-tap the Communications icon, and then select the PC Connection tab.

3 Select Change.

4 In the Connect to desktop computer using list, select Infrared Port.
Note    Your Handheld PC retains these settings after a reset. However, if you clear memory on your device, the 
settings return to the default serial connection.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_infrared_with_your_Handheld_PC')}    Step 3    Connect 
using infrared with your Handheld PC 



Step 3    Connect using infrared with your Handheld PC

1 Align the infrared ports on the two computers. Infrared connections work best when the two infrared ports are
about six inches apart.

2 On your Handheld PC, select Start, Programs, Communications, and then PC Link.

The serial port is the default COM port on your Handheld PC. To use the infrared port, you must change the 
COM port on your Handheld PC.

3 Select Start, Settings, and then Control Panel. 

4 Double-click or double-tap the Communications icon, and then select the PC Connection tab.

5 Select Change.

6 In the Connect to desktop computer using list, select Infrared Port.
Note    Your Handheld PC retains these settings after a reset. However, if you clear memory on your device, the 
settings return to the default serial connection.

Related Topic
Connect to ActiveSync using infrared



Step 2    Set up a modem connection on your Handheld PC

The connection that you create appears as an icon in the Connections window.

1 On your Handheld PC, select Start, Programs, Communication, and then Remote Networking.

2 Double-click or double-tap the Make New Connection icon.

3 In the Type a name for the connection box, enter a unique name for the connection.

4 Select Dial-Up Connection and then select Next.

5 In the Select a modem list, select your modem.

6 If you need to configure port settings or call options, select Configure and make your selections.

7 To connect through a RAS server, select TCP/IP Settings and enter the information received from your 
network administrator.

8 Select Next.

9 Enter the telephone number for your dial-up connection. Select Force long distance if you always want to 
dial this number as a long-distance call. Select Force local if you always want to dial this number as a local 
call.

10Select Finish.

Notes

· If you create a modem connection for an external modem, select Hayes Compatible on COM1 as your 
modem. If you are using a modem card, select its name from the list.

· To use an external modem, you need to use a NULL modem cable and appropriate adapters to connect the 
external modem to your device.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_modem')}    Step 3    Connect using a modem 



Step 2    Install an Ethernet card in your Handheld PC

Important    You must have a NE2000-compatible Ethernet card. 

1 On your device, insert the Ethernet card.

2 In the NE2000 Compatible Ethernet Driver Settings dialog box, select Obtain an IP address via DHCP.
Select OK.

3 Select Start, Settings, and then Control Panel. Double-tap or double-click the Network icon.

4 On the Adapters tab, select NE2000 Compatible Ethernet Driver.

5 On the Identification tab, enter the username, password, and domain name you use to log on to your PC.

Notes

· You do not need to make a new connection on your device for the Ethernet card. When connecting, simply 
select Network Connection.

· Disconnect your cable from your mobile device before attempting to synchronize using a network (Ethernet) 
connection.

What’s next?

{button ,JI(`peg.hlp>second',`Step_3_Connect_using_a_network_Ethernet_connection')}    Step 3    Connect using 
a network (Ethernet) card connection    



Synchronization Topic



Synchronize files from your Handheld PC

To synchronize a file, place it in the special folder used for synchronization called the Synchronized Files folder. 
This file is located at My Handheld PC\My Documents\Synchronized Files on your mobile device.

1 Connect your device to your desktop computer.

2 Click Explore . Windows Explorer will start, and the Mobile Device window will open.

3 In Windows Explorer, browse to the file on your device or desktop computer that you want to synchronize.

4 Select the file and drag it to the Synchronized Files folder. 

Related Topics
Modify Files synchronization settings 

Synchronize files from your desktop computer 



Conversion Topics



Word to Pocket Word conversion on your Handheld PC

ActiveSync converts Word (.doc) files to Pocket Word (.pwd) files, and vice versa whenever you synchronize, 
copy, or move files. Word templates (.dot) are converted to Pocket Word templates (.pwt). After a file is 
converted, you can open it on your mobile device using Pocket Word. 

You may be able to convert Word files sent as e-mail attachments to Pocket Word files on your device. For more 
information, see Pocket Word Help on your device.

All formatting attributes contained in Pocket Word files are retained when converted by ActiveSync to Word files. 
When using ActiveSync to convert Word files to Pocket Word files, many file attributes are retained and appear 
just as they do on your desktop computer. Other file attributes are changed or removed. The following topics list 
the attributes that are supported or not supported in Pocket Word:

Word attributes supported in Pocket Word on your Handheld PC

Word attributes not supported in Pocket Word on your Handheld PC

Notes

· Password protected files cannot be synchronized. Remove the password protection, synchronize the 
document, and then add password protection in the appropriate program at the new location.

· Files saved in Rich Text (.rtf) or Text (.txt) format do not need to be converted to be viewed and edited in 
Pocket Word.

Related Topic
Convert Word files for use on a mobile device 



Word attributes supported in Pocket Word on your Handheld PC

Microsoft Word attributes supported in Pocket Word are displayed without change or are slightly changed during 
conversion.

The following attributes are not changed during conversion.

· Bold · Hidden text · Paragraph spacing · Superscript
· Bullets · Italics · Simple numbered 

lists
· Subscript

· Built-in headings · Paragraph alignment · Strikethrough · Tabs
· Indentation

The following attributes are changed when converting a Pocket Word file to a Word file.

· Index formatting is simplified · Pictures with more than 256 
colors are changed to 256 
colors

· Table formatting is simplified

· Font, font sizes, and colors are
mapped to what is supported 
on your device

· Revision marks are displayed 
but cannot be edited in Pocket 
Word

· Table of contents formatting is 
simplified

· OLE objects are changed to 
bitmaps

Related Topic
Word to Pocket Word conversion on your Handheld PC 



Word attributes not supported in Pocket Word on your Handheld PC

Microsoft Word attributes not supported in Pocket Word are either restored when converted back to Word files or 
are completely removed during conversion.

The following attributes are not supported in Pocket Word but are restored when converted back to a Word file.

· Borders · Shading (when not in a table)

Some Word attributes are not supported in Pocket Word, and are removed when converting a Pocket Word file to 
a Word file.

· Annotations · Footnotes · Page setup information
· Columns · Frames · Shading in tables
· Comments · Headers · Style sheets
· Footers

Related Topic
Word to Pocket Word conversion on your Handheld PC 



About Windows CE Inbox Transfer

When you installed ActiveSync, Windows CE Inbox Transfer was also installed. This program is available from 
Microsoft Outlook or Microsoft Exchange and enables you to copy or move e-mail messages between your mobile
device and desktop computer without synchronizing. If you want to automatically update messages on both your
device and desktop computer, synchronize your messages instead.

What do you want to do?

Copy messages to a mobile device

Copy messages to a desktop computer

Manually send messages 

Note
Windows CE Inbox Transfer may not be supported on all mobile devices.

Related Topics
About copying and moving files

About synchronization 

Modify Inbox synchronization settings 



Copy messages to a mobile device

1 Connect your mobile device to your desktop computer.

2 In Outlook or Exchange, select the messages you want to copy.

3 On the Tools menu, click Windows CE Inbox Transfer.

4 Click Copy selected messages to your mobile device.

5 Set message transfer options, such as the Inbox folder on your mobile device where the messages are to be 
copied.

6 Click Transfer. You can stop copying messages at any time by clicking Stop.

Related Topics
About Windows CE Inbox Transfer    

Copy messages to a desktop computer

Manually send messages



Copy messages to a desktop computer

1 Connect your mobile device to your desktop computer.

2 In Outlook or Exchange, on the Tools menu, click Windows CE Inbox Transfer.

3 Click Copy or move selected messages to your desktop computer.

4 Select whether to copy or move the messages, and set message transfer options, such as the Inbox folder on 
your mobile device where the messages are to be copied from.

5 Select the messages that you want to copy or move from your device.

6 Click Transfer. You can stop copying or moving messages by clicking Stop.

Related Topics
About Windows CE Inbox Transfer    

Copy messages to a mobile device

Manually send messages



Manually send messages

1 Connect your device to your desktop computer.

2 In Outlook or Exchange, on the Tools menu, click Windows CE Inbox Transfer.

3 Click Send Outbox messages for this service, and select the service for your mobile device.

4 Click Transfer. You can stop sending messages at any time by clicking Stop.

Related Topics
About Windows CE Inbox Transfer    

Copy messages to a desktop computer 

Copy messages to a mobile device



Transfers copies of messages selected on your desktop computer to the specified Inbox folder on your mobile 
device.



Locate the Inbox folder on your mobile device where the messages are to be copied.



Copies only a specified number of lines per message to your mobile device. The entire original message remains 
in the mail program on your desktop computer. 



Select the number of lines per message you want transferred.



Copies attachments with messages.



Prompts you to confirm whether to copy attachments with messages.



Copies or moves messages from Inbox on your mobile device to the mail program on your desktop computer.



Locate the Inbox folder on your mobile device that contains the messages you want to copy or move to your 
desktop computer. 



Copies messages to your desktop computer. Original messages remain in Inbox on your mobile device.



Moves messages to your desktop computer. Original messages in Inbox on your mobile device are deleted.



Lists the messages located in the specified mobile device folder. To copy or move any of these messages to your 
desktop computer, select them from the list.



Sends messages in the Outbox folder on your mobile device to the Outbox folder on your desktop computer.



Specify the services for sending Outbox messages.



Click to start transferring the selected messages.



Click to close this dialog box without transferring messages.





Introducing ActiveSync Tour

If you have never used a mobile device before, this tour will introduce you to the concepts and explain how you 
can use this device to exchange the flow of information from your computer to your device. This tour explains 
the following concepts:

Creating a Partnership

Working as a Guest

Synchronizing information

Copying and moving files

Converting files

Synchronizing files

Synchronizing other information types

Adding and removing programs

Backing up and restoring information

Finding more resources



Creating a Partnership

When you set up your device for the first, time you must create a partnership between your computer and your 
mobile device. This is how the information is synchronized, passed back and forth, between your computer and 
your mobile device.

Create a partnership



Working as a Guest

Occasionally you will want to copy or move a file, or add or remove a program from your device and you may not
want to synchronize any information. In this instance you will want to work as a guest . Working as a guest sets 
up a temporary connection where no information is synchronized.

Connect as a guest



Synchronizing information

Synchronizing information enables you to keep information up-to-date on both your computer and your mobile 
device. You can share files, display updated contacts, appointments, and tasks, send and receive e-mail 
messages, and view mobile channel content.

Synchronization



Copying and moving files

There are times when you may want to keep separate versions of information on your computer and on your 
mobile device. If that is the case, copy and move file rather than synchronize by dragging and dropping the files 
into a different folder.

Copy and Move
Related topic:

Synchronizing files



Converting files

Sometimes when files are converted, some of the formatting attributes are changed. For example, note that the 
header and borders are reduced when an Excel file is converted to a Pocket Excel file and, conversely, when the 
Pocket Excel file is converted back to an Excel file the header and border is added back in a slightly different 
format.

File conversion



Synchronizing files

In order to synchronize files it is necessary to keep the files in a specific folder. There will be a specific folder 
both on your desktop and on your mobile device. If you want to maintain different file versions, you can drag and
drop your file into a different folder.

Synchronization Folder
Related topic:

Copying and moving files



Synchronizing other information types

In addition to synchronizing files, you can use ActiveSync to keep your tasks, appointments, contacts, e-mail 
messages, and favorite Web content synchronized.

Synchronization



Adding and removing programs

Occasionally, you will want to add or remove a program such as Pocket Streets, or even a game. If you remove a 
program from your mobile device only, you can always use ActiveSync to reinstall the program later.

Adding a program Removing a program

Backing up and restoring information

Make sure to back up the information on your mobile device to your computer. Then, if for some reason there is a
sudden loss of data, you will be able to restore backed up information.

Backing up data Restoring data

Finding more resources

For more information on using ActiveSync, take a moment to scan the other topics found in ActiveSync Help.

Up-to-date troubleshooting information is available on the Web:

Connection troubleshooter: http://support.microsoft.com/support/pocketpc/tshoot/activesync/default.asp.

Synchronization troubleshooter: http://support.microsoft.com/support/tshoot/pocketpcsync.asp.



Copyright Information

Active Desktop, ActiveSync, ActiveX, Microsoft, Outlook, PowerPoint, Windows, Windows NT, and the Windows CE
logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.

Other product and company names mentioned herein may be the trademarks of their respective owners.



Connection Steps



Step 1    Switch to the serial port on your Pocket PC 2002

Your Pocket PC automatically switches to the Serial Port as necessary. Proceed to step 2.

What’s next?

{button ,JI(`peg.HLP>second',`Step_2_Connect_using_a_serial_cable_or_a_cradle')}    My device is using the 
serial port. Go to step 2. 



Step 2    Switch to the infrared port on your desktop computer

To connect to your desktop computer with infrared, on the File menu, click Connection Settings. In the Allow 
serial cable or infrared connection to this COM port list, select Infrared Port (IR). Proceed to step 3.

What’s next?

{button ,AL(`ainfrared3',1,`',`second')}    My desktop computer is using the Infrared port. Go to step 3. 



Step 3    Connect using infrared with your Pocket PC 2002

1 Align the infrared ports on the two computers according to the instructions in your owner's manual so that 
they are unobstructed and within a close range.

2 On your Pocket PC, tap , ActiveSync, Tools, and then Connect via IR.

Related Topic
Connect to ActiveSync using infrared



Step 2    Set up a modem connection on your Pocket PC 2002

Use the following steps to create a modem connection. 

1 Tap , Settings, Connections tab, and then Connections.
2 To connect to an ISP, under the Internet settings, tap Modify. Otherwise, under the Work settings, tap 

Modify. 

3 On the Modem tab, tap New. 

4 Enter a name for the connection, such as "Corporate Modem." 

5 In the Select a modem list, tap your modem type. If you are using an external modem, tap Hayes 
Compatible on COM1. 

6 You should not need to change any settings in Advanced. Most servers now use dynamically-assigned 
addresses. If the server you are connecting to does not use dynamically-assigned addresses, tap Advanced 
and enter your TCP/IP settings. When finished, tap OK and then Next. 

7 Enter the access phone number and tap Next. 

8 Select other desired options and tap Finish. 

Note    To create a more secure connection, select VPN settings on the VPN tab. For more information, see 
Connections Help on your device.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_modem')}    Step 3    Connect using a modem 



Step 2    Install an Ethernet card in your Pocket PC 2002

Important    You must have an NE2000-compatible Ethernet card. 

Ethernet drivers should already be installed on your device.

1 Get the following information from your network administrator: user name, password, and domain name. 

2 Insert the Ethernet card into your device.

3 The first time you insert the card, Network Settings will appear automatically. If it does not appear or to 
change settings later, tap , Settings, Connections tab, and then Network Adapters. 

4 Tap the Identification tab and enter your user information. See your network administrator if you need 
assistance. 

5 If you need to enter specific server information, tap the Adapters tab and then your Ethernet driver. Most 
networks use DHCP, so you should not have to change these settings unless your network administrator 
instructs you to do so. 

6 To select a location for your network card to connect to, tap  , Settings, Connections tab, Connections. 
From the My network card connects to list, select Internet to connect to an ISP. Otherwise, select Work.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_network_Ethernet_connection')}    Step 3    Connect using
a network (Ethernet) card connection    



Synchronized Files



Synchronize files from your Pocket PC 2002

All files you create on your Pocket PC are stored in the My Documents folder on your mobile device, which is the 
special folder used for synchronization. If the Files information type is selected for synchronization, all of the files
you create on your device are synchronized with your desktop computer.

Related Topic
Modify Files synchronization settings 

Synchronize files from your desktop computer 



Conversion Topics



Word to Pocket Word conversion on your Pocket PC 2002

ActiveSync converts Word (.doc) files to Pocket Word (.psw) files, and vice versa whenever you synchronize, 
copy, or move files. Word templates (.dot) are converted to Pocket Word templates (.psw). After a file is 
converted, you can open it on your mobile device by using Pocket Word. 

You may be able to convert Word files sent as e-mail attachments to Pocket Word files on your device. For more 
information, see Pocket Word Help on your device.

Written notes and drawings created on your device are converted to metafiles for use on your desktop computer.
All other formatting attributes contained in Pocket Word files are retained when converted to Word files. 

When converting Word files to Pocket Word files, many file attributes are retained and appear just as they do on 
your desktop computer. Other file attributes are changed or removed. The following topics list the attributes that 
are supported or not supported in Pocket Word:

Word attributes supported in Pocket Word on your Pocket PC

Word attributes not supported in Pocket Word on your Pocket PC

Notes

· Password-protected Word (.doc) documents cannot be synchronized. Remove password protection in Word, 
and then synchronize the document.

· Files saved in Rich Text (.rtf) and Text (.txt) formats do not need to be converted to be viewed and edited in 
Pocket Word.

· Handwritten notes and drawings created in Pocket Word (.psw) are converted to Word (.doc) files as metafiles.

Related Topic
Convert Word files for use on mobile devices 



Word attributes supported in Pocket Word on your Pocket PC 2002

Microsoft Word attributes supported in Pocket Word are either displayed without change or are slightly changed 
during conversion.

The following attributes are not changed during conversion.

· Bold · Simple numbered lists · Paragraph spacing
· Bullets · Strikethrough
· Italics · Paragraph alignment

The following attributes are changed when converting a Pocket Word file to a Word file.

· Indentation may be 
changed to provide better 
readability on the device.

· OLE objects are changed 
to bitmaps.

· Table formatting is 
removed, but text is 
preserved.

· Index formatting is lost, but 
text remains.

· Pictures with more than 
256 colors are changed to 
256 colors.

· Table of contents 
formatting is lost, but text 
remains.

Related Topic
Word to Pocket Word conversion on your Pocket PC 



Word attributes not supported in Pocket Word on your Pocket PC 2002

Microsoft Word attributes not supported in Pocket Word are either restored when converted back to Word or 
completely removed during conversion.

The following attributes are not supported in Pocket Word but are restored when converted back to a Word file.

· Margins · Gutter size · Header/footer 
vertical location

· Paper size

Some Word attributes are not supported in Pocket Word and are removed when converting a Pocket Word file to 
a Word file.

· Annotations · Comments · Frames · Revision marks
· Borders · Footnotes · Headers · Shading
· Columns · Footers · Page setup 

information, such as 
paper source and 
layout

· Style sheets

Related Topic
Word to Pocket Word conversion on your Pocket PC 



Connection Steps



Step 1    Switch to the serial port on your Pocket PC

Your Pocket PC automatically switches to the Serial Port as necessary. Proceed to step 2.

What’s next?

{button ,JI(`peg.HLP>second',`Step_2_Connect_using_a_serial_cable_or_a_cradle')}    My device is using the 
serial port. Go to step 2. 



Step 2    Switch to the infrared port on your Pocket PC

Your Pocket PC automatically switches to the Infrared Port as necessary. Proceed to step 2.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_infrared_with_your_Palm_size_PC_version_2')}    My device 
is using the Infrared port. Go to step 3. 



Step 3    Connect using infrared with your Pocket PC

1 Align the infrared ports on the two computers according to the instructions in your owner's manual so that 
they are unobstructed and within a close range.

2 On your Pocket PC, tap , Programs, Connections, and then IR ActiveSync.

Related Topic
Connect to ActiveSync using infrared



Step 2    Set up a modem connection on your Pocket PC

Use the following steps to create a modem connection. The connection that you create appears as an icon in the 
Connections window.

1 Tap , Settings, Connections tab, and then Modem.

2 Tap New Connections.

3 Enter a name for the connection, such as "Corporate Connection."

4 In the Select a modem list, select your modem type. If you create a modem connection for an external 
modem, select Hayes Compatible on COM1 as your modem. If you are using a modem card, select its 
name from the list.

5 Tap Advanced and enter your TCP/IP settings. When finished, tap OK and then Next.

6 Enter the access phone number and tap Next.

7 Select other desired options, and tap Finish.
Note    To use an external modem, you need to use a NULL modem cable and appropriate adapters to connect 
the external modem to your device.

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_modem')}    Step 3    Connect using a modem 



Step 2    Install an Ethernet card in your Pocket PC

Important    You must have an NE2000-compatible Ethernet card. 

Ethernet drivers should already be installed on your device.

1 Get the following information from your network administrator: user name, password, and domain name. 

2 Insert the Ethernet card into your device.

3 The first time you insert the card, Network Settings will appear automatically. If it does not appear or to 
change settings later, tap , Settings, Connections tab, and then Network. 

4 Tap the Identification tab and enter your user information. See your network administrator if you need 
assistance. 

5 If you need to enter specific server information, tap the Adapters tab and then your Ethernet driver. Most 
networks use DHCP, so you should not have to change these settings unless your network administrator 
instructs you to do so. 

What’s next?

{button ,JI(`peg.HLP>second',`Step_3_Connect_using_a_network_Ethernet_connection')}    Step 3    Connect using
a network (Ethernet) card connection    



Synchronized Files



Synchronize files from your Pocket PC

All files you create on your Pocket PC are stored in the My Documents folder on your mobile device, which is the 
special folder used for synchronization. If the Files information type is selected for synchronization, all of the files
you create on your device are synchronized with your desktop computer.

Related Topic
Modify Files synchronization settings 

Synchronize files from your desktop computer 



Conversion Topics



Word to Pocket Word conversion on your Pocket PC

ActiveSync converts Word (.doc) files to Pocket Word (.psw) files, and vice versa whenever you synchronize, 
copy, or move files. Word templates (.dot) are converted to Pocket Word templates (.psw). After a file is 
converted, you can open it on your mobile device by using Pocket Word. 

You may be able to convert Word files sent as e-mail attachments to Pocket Word files on your device. For more 
information, see Pocket Word Help on your device.

Written notes and drawings created on your device are converted to metafiles for use on your desktop computer.
All other formatting attributes contained in Pocket Word files are retained when converted to Word files. 

When converting Word files to Pocket Word files, many file attributes are retained and appear just as they do on 
your desktop computer. Other file attributes are changed or removed. The following topics list the attributes that 
are supported or not supported in Pocket Word:

Word attributes supported in Pocket Word on your Pocket PC

Word attributes not supported in Pocket Word on your Pocket PC

Notes

· Password-protected Word (.doc) documents cannot be synchronized. Remove password protection in Word, 
and then synchronize the document.

· Files saved in Rich Text (.rtf) and Text (.txt) formats do not need to be converted to be viewed and edited in 
Pocket Word.

· Handwritten notes and drawings created in Pocket Word (.psw) are converted to Word (.doc) files as metafiles.

Related Topic
Convert Word files for use on mobile devices 



Word attributes supported in Pocket Word on your Pocket PC

Microsoft Word attributes supported in Pocket Word are either displayed without change or are slightly changed 
during conversion.

The following attributes are not changed during conversion.

· Bold · Simple numbered lists · Paragraph spacing
· Bullets · Strikethrough
· Italics · Paragraph alignment

The following attributes are changed when converting a Pocket Word file to a Word file.

· Indentation may be 
changed to provide better 
readability on the device.

· OLE objects are changed 
to bitmaps.

· Table formatting is 
removed, but text is 
preserved.

· Index formatting is lost, but 
text remains.

· Pictures with more than 
256 colors are changed to 
256 colors.

· Table of contents 
formatting is lost, but text 
remains.

Related Topic
Word to Pocket Word conversion on your Pocket PC 



Word attributes not supported in Pocket Word on your Pocket PC

Microsoft Word attributes not supported in Pocket Word are either restored when converted back to Word or 
completely removed during conversion.

The following attributes are not supported in Pocket Word but are restored when converted back to a Word file.

· Margins · Gutter size · Header/footer 
vertical location

· Paper size

Some Word attributes are not supported in Pocket Word and are removed when converting a Pocket Word file to 
a Word file.

· Annotations · Comments · Frames · Revision marks
· Borders · Footnotes · Headers · Shading
· Columns · Footers · Page setup 

information, such as 
paper source and 
layout

· Style sheets

Related Topic
Word to Pocket Word conversion on your Pocket PC 




